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Customer Support
Outside North America, contact your local HP dealer
HP Authorized Dealers and Service: 800-752-0900

(In Canada contact the Customer Information Center 800-387-3867)

HP End User Technical Support
HP's Automated Support Access Program: 800-333-1917

24 Hour Access to:
1. Audio-Tips (Recorded Answers to Common Questions)
2. HP FIRST (FAX yourself information on HP products)

(outside the USA call -208-344-4809)
Customer Support Center: 208-323-2551

Post sales Technical Support (7am-6pm MST) (WED 7am-4pm)

Supplies and Accessories
Accessories and Replacement Parts 
Contact your HP Authorized Dealer or call 800-538-8787

Printer Driver Distribution
To order a copy of HP LaserJet Printer Drivers or printing software, call Hewlett-Packard 
Distribution Center at 303-353-7650.    

Outside North America, contact your authorized HP dealer.



Trademark Acknowledgments
Bi-Tronics(tm) is a trademark of Hewlett-Packard Company.    Microsoft is a U.S. registered trademark
and Windows(tm) is a trademark of Microsoft Corporation.

Notice 



Notice
HEWLETT-PACKARD MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE.

Hewlett-Packard shall not be liable for errors contained herein or for incidental or consequential 
damages in connection with the furnishing, performance, or use of this material.

This software program (HP LaserJet 4L Printing System) contains proprietary information that is 
protected by copyright.    All rights are reserved.    No part of the information may be reproduced or 
altered or translated to another language without the prior written consent of Hewlett-Packard 
Company.

The information contained in this program is subject to change without notice.



Accessories and Replacement Parts
Memory Card 
With Memory Enhancement technology, additional memory is only needed if you will be printing 
complex graphics or need additional memory space for soft fonts and/or macros.

The part number for the optional 1 megabyte memory card is HP C2024A.

Toner Cartridge
The Toner Cartridge part number for your HP LaserJet 4L printer is HP 92274A.

Printer Cable
The HP part number for the bi-directional printer cable is G2912B



Information Messages
Engine Test 
Form Feeding 
Intelligent Off 
Memory Error 
Test Page Printout 



Paper Handling Messages
Add Paper 
Feed Envelope 
Feed Paper 



Intervention Required Messages
Check Toner and Cover 
Clear Paper Jam 



Communication Messages
Check Printer/Cable 
Status Not Available 



Hardware Error Messages
Engine Beam Error 
Engine Communication Error 
Engine Fan Error 
Engine Fuser Error 
Engine Scanner Error 
Firmware Error 
General Hardware Fault 
Processor Error 
RAM Error 
ROM Error 



What's in the New Print Manager?
The Print Manager provided with the HP LaserJet 4L Printing System is an enhanced version of the 
Print Manager provided with Windows 3.1.    The toolbar has more buttons, and icons replace button 
names.    

When Print Manager lists an HP LaserJet 4L printer, you can open the Status Window for the selected
printer.    Otherwise, Print Manager works the same way.

To open the Status Window from Print Manager
1. In the Main group window, choose the Print Manager icon.    Alternatively, if Print Manager is 

already active, choose the Print Manager icon from the desktop.    

If Print Manager is turned off, choose the Printers icon in Control Panel, and then select the Use 
Print Manager check box.

2. Select your HP LaserJet 4L printer in the Print Manager window.
3. Choose the Printer Status Window command from the View menu in Print Manager or press the

 button on the toolbar.

Note: Print Manager must be turned on and running for the Status Window to function.

See also
Print Manager Help



Feed (size) Paper
The printer is requesting that you place a sheet of paper, face up, in the Manual Feed Slot.

Printing from the Manual Feed Slot

The Manual Feed Slot is used for:
Feeding one sheet of paper (letterhead).
Envelopes.
Adhesive Labels.
Heavy or special papers.

Manual Feed Slot Paper Specifications 



Manual Feed Slot Paper Specifications
Cutsheet paper Dimensions
A4 8.27 x 11.69 in. (210 x 297 mm)
Letter 8.5 x 11 in. (216 x 279 mm)
Legal 8.5 x 14 in. (216 x356 mm)
Executive 7.25 x 10.5 in. (191 x 267 mm)

Special Paper
Envelopes, Transparencies, Labels, Colored Paper

The maximum capacity is one sheet (minimum 3 in. by 6.75 in., 76mm by 171mm). If you feed paper 
heavier than #28 (105 g/m2), use the rear output slot.

It is possible for paper to meet all the general specifications, and still not print satisfactorily. For this 
reason, we recommend that you test any paper before buying in large quantities.



Feed (size) Envelope
The printer is requesting that you place an envelope in the Manual Feed Slot.    Hold the envelope so 
that the return address is on the lower left, face up.

Be sure to select the rear output path    on the printer by gently pushing the paper path knob on the 
rear of the printer to the down position.

Envelope Considerations 

Margins and Envelopes 

Envelope Specifications 





Envelope Considerations
Before purchasing large quantities of envelopes, test a small number to determine their performance 
through your printer.

Envelopes also must:
Contain no windows, clasps, or snaps.
Withstand 392° F (200° C) for 0.1 second. 

(self stick adhesives must also withstand the same temperatures)
Have no adhesive areas exposed to the printer.
Be undamaged, unwrinkled, and have no torn edges.
Be sharp and well-creased.
Lie flat with no more than 0.2 in (5 mm) of curl.
Be tightly constructed.
Be made of 100% chemical wood pulp and/or fiber.
Have a smooth texture.
Have folds which connect to the edges of the envelope.



Envelope Specifications
Sizes:

Minimum: 3.87 x 7.5 inches (96 mm x 108 mm)
Maximum: 8.27 x 11.69 inches (164 x 255 mm)

Weight: 16 to 24 pound (60 to 90 grams/m²)
COM 10: 4.1 in. x 9.5 in. (105 mm x 241 mm)
Monarch: 3.87 in. x 7.5 in. (98 mm x 191 mm)
DL: 110 mm x 220 mm (4.33 in x 8.66 in)
C5: 162 mm x 229 mm (6.38 in x 9.01 in)
B5: 178 mm x 251 mm (7.0 in x 9.9 in)

Use the rear output path for printing quality envelopes.



Add (size) Paper
The printer has run out of paper and is requesting that you load paper into the paper tray.

The Paper cassette can hold up to 100 sheets of Executive, Letter, A4 or Legal size paper.    It does 
not support envelopes.    Be sure to use the rear exit path for envelopes, it will cause less curl.

See also
Loading the Paper Cassette 

Adjusting the Paper Cassette 

Paper Cassette Specifications 



Loading the Paper Cassette
1. Pull out the paper cassette.

2. Push the paper size guide 
toward the center of the 
cassette to free it from its notch, 
then adjust it for your size paper.

3. Fill the cassette with about 
100 sheets of 20 pound (75 
g/m2) paper. Load letterhead 
face down, with the bottom of 
the page feeding into the printer 
first.

4. Be sure to insert the edge of 
the paper stack under the clip at
the front of the cassette.

5. Rest the cassette on the table
and slide it into the printer.

Note: Be careful that you don't load legal paper into the paper tray and then send a letter size print 
job to your printer. Doing so will cause a paper jam.



Adjusting the Paper Cassette
1. Pull out the Paper Cassette 
and remove any paper.

2. Push the paper size guide 
toward the center of the 
cassette to free it from its notch 
then slide the notch to the 
paper size you will be using (top
picture).

3. Add the proper size paper, 
making sure that the paper 
stack is below the metal tabs 
(middle and bottom pictures).

Note:    Be careful that you don't load legal paper and then send a letter size print job to your printer. 
This will cause a paper jam.

Setting paper size from software defines the paper size.



Paper Cassette Specifications
Media Size Capacity Weight / Thickness
Paper Letter 100 sheets 16 to 28 pound (60 to 105 g/m²)

A4 100 sheets 16 to 28 pound (60 to 105 g/m²)
Executive 100 sheets 16 to 28 pound (60 to 105 g/m²)
Legal 100 sheets 16 to 28 pound (60 to 105 g/m²)

We do not recommend printing overhead transparencies, labels, or envelopes from the Paper 
Cassette. Use the Manual Feed Slot for these media.



Rear Output Slot

Use the Rear Output Slot to print envelopes, labels, transparencies and paper heavier than #28 (105 
g/m2).    You select the Rear Output Slot by pressing the paper path knob downward.



Margins and Envelopes
When entering the address, make sure you
allow for a small margin (.6 inch/15 mm) 
between the top and left edge of the 
envelope, and the return address.

Printing very close to the edge of the 
envelope may result in poor print quality.

Remember to format the envelope in 
landscape orientation.



Check Toner and Cover
There is a problem with the printer.

The printer door is not closed entirely or there is a problem with the toner cartridge (it may be 
missing).

Check that the printer door is completely closed.    Press firmly on the door until it closes.
Check the toner cartridge.    Remove the toner cartridge, then reinstall it.



Clear Paper Jam
Clearing Paper Jams - Follow these steps
1. Open the top cover by pressing the cover release button on the right side of the printer.
2. Take out the toner cartridge.
3. Pull out the paper cassette.
4. If paper is in the paper feed area, pull the paper to the right to release it from the feed roller. Then 

pull the paper straight out.
5. If step 4 above clears the jam, replace the paper cassette and the toner cartridge, then close the 

top and rear doors.
6. The printer should return to the ready state. If it does not, there is still jammed paper in the 

printer. Check other areas of the printer

If the paper has gone completely into the printer
1. While holding the printer steady, carefully pull the jammed paper toward you to remove it.
2. Do not pull the paper straight up when removing it. The toner on the paper may stain the printer 

and affect the print quality. If this happens, take the printer to a Hewlett-Packard Service Center.
3. If the trailing edge of the paper is under the transparent cover, pull the paper toward you to 

remove it.
4. If the paper is difficult to remove, open the printer's rear access door.    While pushing the paper 

release lever up, pull the paper straight toward you.
5. Replace the paper cassette and the toner cartridge, then close the top cover and rear doors.

The printer should return to the Ready state. If it does not, try one of the following remedies:

a. Check to see if there is more jammed paper in the printer.
b. Open and close the printer's top door or press the front panel button briefly.

See also
Why paper jams occur 



Why Paper Jams Occur
Usually paper jams occur when:
1. You have specified a Letter size print job, but have Legal size paper loaded in the paper cassette.
2. Your print media does not meet the listed specifications.
3. The media is in poor condition.
4. The printer needs cleaning.
5. The rear door is open (this causes a paper jam message, but there may not always be jammed 

paper in the printer).
6. Removing the paper cassette while a job is printing.
7. Filling the paper cassette too full.

If paper jams occur often, clean the printer and check the quality of your paper or other print media. If 
paper jams occur continually from the paper cassette, contact your local Hewlett-Packard Service 
Center .



Unknown Error
The Status Window has received an unrecognized error from the printer.

Check that you are using an HP LaserJet 4L printer.    The Status Window is not designed to work with
other printers.

You can print a Test Page    to verify the type of printer you are using.

If your printer is an HP LaserJet 4L and you received an unknown error, power cycle the printer by 
unplugging it, and then plugging it back in.    If the message reappears, write down the error code and 
contact your authorized Hewlett-Packard Service Center.



Form Feeding
Your printer has been instructed to form feed unprinted data still in the printer.

There is no problem with the printer.

After the page has been printed, the printer will return to the Ready state and will accept new data.



Test Page Printout
Your printer is printing a Self Test Page

There is no problem with the printer.

After the page has been printed, the printer will return to the Ready state and will accept new data.

Printing a Self Test 



Engine Test
Your printer is performing an Engine Test.

There is no problem with the printer.

After the test has completed, the printer will return to the Ready state and will accept new data.



Intelligent Off
The printer has not been used for 15 minutes and has entered Intelligent On/Off Mode.

There is no problem with your printer.

It will become active automatically when you do any of the following:
Touch the front panel button
Remove or insert the paper cassette
Send data to the printer
Open the printer door
Insert paper into the Manual Feed Slot

When it is in Intelligent OFF mode, your printer will use about 5 watts of power.



Printing a Self Test

To print a Self Test Page:
1. Make sure the Ready Light is on and all other lights are off. (If necessary, reset the printer).
2. Press the control button for one second then release it.
3. After about 6 seconds, the Self Test Page will print. Usually, only one page prints. If you have 

downloaded fonts or macros, a second page prints.



Memory Error
Your printer has run out of memory while preparing a page.

There are two types of memory error that can occur, Print Overrun and Out of Memory.    

There are settings you can change within the Printer Driver Setup that can help resolve these 
problems.    For more details, click on the Printer Driver Help topic below.

Printer Driver Help



Status Not Available
The Status Window could not establish two-way communication with the printer.

Refer to the help section on checking the connection between the computer and printer by clicking on 
the topic below.

Check Printer/Cable 



Check Printer/Cable
Your computer and HP LaserJet 4L printer are not communicating.

Check that the printer is:
1. Configured to the correct port. 

2. Connected to a live power source. 

3. Connected directly to your computer. 

4. An HP LaserJet 4L printer .

5. Functioning correctly.

Also check:
Is the cable you are using compatible with Bi-Tronics    ?
Is the cable in good condition?



Your printer may be configured to the wrong port
If your printer is connected to the wrong port, you will get a communications error. Try the following:

1. Run the Windows Control Panel and double click on the Printer icon.
2. Check that the ports on your computer are functioning and are labeled correctly.



Is the printer connected to a power outlet that is energized ?

Try a power outlet which you know is energized.    If this resolves the problem, have a certified 
electrician check the outlet which didn't work.

Is the power cable good?
Exchange the power cable with another cable which you know is functional.



Is your printer connected directly to the computer ?

Check the cable from your printer.    It could be: Loose, bad, or missing.



Are you using a Hewlett-Packard LaserJet 4L printer ?

The HP LaserJet Status Window program included with your printer software will only work with an 
HP LaserJet 4L printer.    It is not designed to work with other printers.

Try printing a Test Page .



Bi-Tronics Cables
Your Hewlett-Packard LaserJet 4L printer has bi-directional electronics which allows two way 
communications between the printer and computer.

For your printer to function properly, you must be using a cable with pin-to-pin wiring which supports 
bi-directional communications.

Most standard parallel cables sold today support bi-directional communication.

The HP part number for the bi-directional cable is G2912B



General Hardware Fault
There is a problem with hardware in your printer.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center .



ROM Error
There is a problem with the ROM memory in your printer.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center .



RAM Error
There is a problem with the RAM memory in your printer.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center .



Engine Fuser Error
There is a problem with the fuser of your printer.

Unplug the printer, wait 15 minutes, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center .



Engine Beam Error
There is a problem with the engine of your printer.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center.



Engine Scanner Error
There is a problem with the engine of your printer.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center.



Engine Fan Error
There is a problem with the Fan in your printer.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center .



Engine Communication Error
Your printer's engine is not communicating correctly.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center .



Firmware Error
There is a problem with the firmware of your printer.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center .



Processor Error
There is a problem with the processor in your printer.

Unplug the printer, and then plug it back in.

If the message reappears, write down the error and contact your authorized Hewlett-Packard Service 
Center .



What's in the Status Window
With the Status Window, you see exactly what is happening to the printer and to the document being 
printed.    The Status Window has a title bar that identifies your printer and a menu bar for commands.

Just below the menu bar is the job information box, which includes the job title (printing state, 
application name and file name) and either the job start time or a message.    

The rest of the Status Window contains a picture that graphically illustrates the current status of your 
printer.

Note: The Status Window will only work with an HP LaserJet 4L printer.

See also
Customizing the Status Window 

Responding to Messages 



Responding to Messages
With two-way communication, the HP LaserJet 4L Printing System can display a Status Window that 
gives you immediate and complete information about the current print job.

Information messages inform you of a printing condition
that will eventually require your attention, but will not 
prevent your print job from finishing.

Alerts, which cause the Status Window to open 
automatically, alert you to a condition that must be 
resolved before printing can continue. Sometimes, this 
message is a reminder to do something such as 
inserting a page into the manual feed slot. The alert 
message will always be accompanied by directions on 
how to resolve the situation. Follow the directions 
provided, and printing will resume automatically.

Display Options Dialog Box
Use the Display Options dialog box to customize the Status Window.    You can:

Determine whether the Status Window should open automatically when printing starts.
Ensure that the Status Window remains on top of any other windows displayed.
Select whether sounds accompany messages.

Note: The Status Window always opens to display an alert, regardless of whether Display Printer 
Status While Printing is selected.

To customize the Status Window:
1. Choose the Display command from the Options menu in the Status Window.
2. Select the options that you desire.
3. Choose the OK button.

See also
Accompanying Messages with Sounds 



Accompanying Messages with Sounds
Sound files are included in the HP LaserJet 4L Printing System that provide an audible indication of 
various messages that display in the Status Window.    The Status Window can play these messages 
when appropriate.

To turn sounds on or off:
1. Choose the Display command from the Options menu in the Status Window.
2. In the Display Options dialog box, select the Play Sounds with Messages option.
3. Choose the OK button.

You can use the Windows Control Panel to turn individual sounds on or off, as well as change the 
messages to different sounds by re-assigning the printing event to a different sound file.

Table of Sound Events 

Important: The PC Speaker driver may not produce high quality sounds on all computer systems, 
since the performance of the speaker driver is largely dependent upon the computer hardware itself.   
Neither HP nor Microsoft guarantee that the PC Speaker driver will work with all computer systems.



Sound Events and Filenames
Event Sound Filename
Out of paper paddpap.wav
Paper is jammed pjam.wav
Printer cover is open pcover.wav
Printer not 
responding

pcommerr.wav

Printer returned error perror.wav
Ready for next sheet pfeed.wav

Paused
While printing with the HP LaserJet 4L Printing System, you pressed the Pause button in Print 

Manager. To resume printing, press the Resume button  in the Print Manager toolbar.
See also

Print Manager Help



Printing
You are currently printing a document with your HP LaserJet 4L Printing System.    The information 
box below the menu bar is displaying the title, application name and file name of the current print job, 
and the time the job started printing .



Printer Ready
Your printer is ready to print.

There is no problem with the printer.

If you would like more information on the Status Window:
What's in the Status Window 



About Box
The about dialog box shows the copyright notice and version number of your HP LaserJet 4L Printing 
System.




